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StealthViz User Manual (original) >> 

 

VA scan types 

CT         4:1.0 

T1      3:8:1.0 

F3 (cubic FLAIR) 5500:1.0 

DTI (3 mm)  6000:3.0 

DTI (2 mm)  7000:2.0 

 

Loading CDs on Stealth Station – always use “Unstructured DICOM” format. 
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HDH scan types 

DTI   10900:2.0 or 11000:2.5 

T1 wo   1800:1.0 

T1 w   2000:1.0 

FGATIR  3000:1.0 

F3 (cubic FLAIR) 5000:1.0 

SWI   20:28:1.5 

 

StealthViz 

StealthViz implements a fast version of the Fiber Assignment by Continuous Tracking (FACT) algorithm licensed 
from Johns Hopkins Univ.  It is a deterministic algorithm. 

 

HELP DESK 

800-595-9709 

 

Bruce Leggett 

bruce.leggett@medtronic.com 

 

Jennifer Halcome 

jennifer.halcome@medtronic.com 

303.434.4764 
 

Danielle Steffens  
Associate Technical Services Specialist | Medtronic Navigation  

826 Coal Creek Circle | Louisville, CO 80027 USA  

Technical Support | US +1.800.595.9709 | OUS +1.720.890.3200  

danielle.e.steffens@medtronic.com 

 

Brittany Kuehl  
Associate Technical Support Specialist | Services | Medtronic, Inc.  

826 Coal Creek Circle | Louisville, CO 80027 USA  

MNav Tech Support 1-800-595-9709  

brittany.v.kuehl@medtronic.com 

 

Ben Ewing  
GSS Contact Center Supervisor | Medtronic Surgical Technologies 

867 Coal Creek Circle | Louisville, CO 80027 USA  

benjamin.ewing@medtronic.com 

US +1.800.595.9709 | OUS +1.720.890.3160 

 

dl.navstealthvizsupport@medtronic.com or you can call the Tech Support hotline at 1-800-595-9709 (Ask for 
Brittany, Dani, or Ben). 

 

 

Imaging Protocols for StealthViz Software 

To perform fiber tracking with the StealthDTI module of the StealthViz application software, you need an 
anatomical scan and a set of diffusion-weighted scans. For the anatomical scan, image the patient using 
the general instructions for the cranial application in the Medtronic Imaging Protocols document (9732379). 
Follow the additional instructions for the diffusion-weighted imaging protocols below. 
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Specific Requirements for Diffusion-Weighted Scans 
StealthDTI can accept diffusion-weighted scans from scanners manufactured by: 

■ GE 
■ Siemens 
■ Philips 

Oblique scans are supported using the latest scanner software offered by GE or Siemens. 
■ If you are using a Phillips scanner, turn off the “Overplus” option. 
■ If you are using a Siemens scanner plus DICOM/Mosaic, check the “Rotate gradients if applicable” box 
before you load the exam into the StealthDTI software. 

The StealthDTI module of StealthViz does not support averaging of the diffusion weighted images. Only 
protocols with a single B0 are supported. 
 

Scan Transfer 
Archive the exam from the scanner to a CDR in non-volumetric DICOM format. StealthDTI does not 
support Siemens' mosaic format or Philips PAR/REC format. Alternatively, you may transfer the exams 
electronically to the StealthViz planning station via a DICOM network. 
 

Assistance 
For questions about the StealthDTI Imaging Protocols or for information about using scanners from 
manufacturers not listed above, contact your local Computer-Assisted Surgery Specialist or call Medtronic 
Navigation for technical support at (+1) 800.595.9709 or (+1) 720.890.3200. 
 

 

IMPORT Datasets 

IMPORT tab 

• [File] (in toolbar) → Import DICOM → choose from drop-down menu “user/people/exams” → select 

exam volume (only imports one at the time) → OK → “Convert” → “Close tab” in the left panel → 

click “Query” (new dataset appears on the list) 

• select exam(s) → “(Add to) view” 

• saved sessions on that dataset are displayed in the lower right window; may choose “Show Most 

Recent Sessions”. 

  

 

MERGING (FUSING) 

A METHOD 

• make sure both exams are visible on fusion display. 

• activate “fusion registration” toolbar ([View] → Show toolbars) 

• click “Auto Registration” button → “Accept Registration” 

N.B. sometimes need to “Align centers” and do provisional “Manual Registration” to get as 

close to ideal merge as possible and then use “Auto Registration” 

 

B METHOD 

[Tools] (in toolbar) → Coregistration 

 

SEGMENTATION 

Materials = (Segmentation) Objects 

• two objects cannot overlap (one voxel cannot be assigned to two separate objects). 

• “MPR view” window does not show R or L labels (H: create object and check it in VIEW tab). 

http://www.neurosurgeryresident.net/
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Ctrl-Z – undo steps (unlimited) 

 

MATERIALS list (top right) 

EXTERIOR – all voxels not assigned to objects 

“Eye” icon – display or hide object 

“Lock” icon – lock object to prevent accidental editing 

“Select” – to select that object (object gets red overlay). 

 

• right-click on object (in the list) for visualization options. 

 

 

SELECTION area (on the right) 

vs. SELECTION menu in toolbar 

 

Current slice vs. All slices – actions on current axial slice vs. on entire object. 

“Eraser” – to deselect object (it does not erase object!). 

“Recycle (update)” – selection becomes new selected region (if selection touches previous selection then 

unselected voxels from old selection will be deleted). 

“Plus”, “Minus” – selected areas are added / deleted from previous selection. 

 
 vs.  - toggle display (one or three MPR views) 

  

 

 

TOOLS area (on the right) 

“Arrow” (pick region) – click and drag selection area (holding SHIFT allows to rotate it) 

“Brush” – selects area by brushing (area below lets to change brush parameters) 

N.B. to erase – use “Brush” and hold CTRL 

“Lasso” – select by lasso 

“Auto trace” works like magnetic lasso 

“Freehand” with ALT leaves attachment points 

“Magic wand” – select using histogram (click in area of interest and then adjust histogram) – excellent 

for selecting fMRI activation region 

“Blow” – selects by selective blow 

 

 

SEGMENTATION TIPS 

• 3D objects are associated with one anatomical exam, so if you want to see all 3D objecst at the same 

time, make sure you do segmentation when the same anatomical exam is chosen as primary dataset 

when you do segmentation or later, when you view 3D objects (if you will chose different anatomical 

exam as primary, 3D objects won’t be on the list) 

N.B. when anatomical exam is chosen as primary dataset (in VIEW tab), then 

SEGMENTATION tab will also show it; if you want to use different exam for 

segmentation (e.g. fMRI), choose it using SEGMENTATION (in toolbar) → Grey image 

→ fMRI exam; 

if needed fMRI is greyed out, it means it wasn’t fused with anatomical exam; for merging 

do not use “Auto Registration” (as there is no enough anatomical data in fMRI to fuse), 

http://www.neurosurgeryresident.net/
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instead look if fMRI activation regions sit in appropriate place on anatomical exam (in 

fusion display mode) and then just click “Accept Registration” 

• use “Blow” then fine-tune with “Brush”, Ctrl+ 

• make selections every few slices then: SELECTION (in tool bar) → INTERPOLATE* 

N.B. when done, click “Plus” to make selection an object (or to add to existing object) 

*interpolates in one axis (vs. WRAP – interpolates in 

all 3 axes) 

 

BEST ANATOMICAL EXAMS FOR SEGMENTING 

(always verify with FA map): 

cerebral peduncle – FGATIR 

red nucleus – CUBE FLAIR, SWI (FGATIR does not show) 

thalamus – FGATIR 

 

 

How to work on existing 3D object 

• SEGMENTATION tab. 

• SEGMENTATION in toolbar → Gray Image → select primary anatomical (reference) exam – you 

will see outline of existing 3D objects (associated with this anatomical exam). 

• now use regular selection tools (e.g. brush) and ADD (+) or DELETE (-) selections from existing 3D 

object (make sure that object is selected in “Objects” area). 

 

 

How to merge two separate objects 

(even from two separate datasets as long as they associated with same anatomical exam) 

A. Segment one dataset, then go to another dataset (as another grey image) – you still will see outlines 

of previously created 3D object; stay on the same object (in “3D objects” toolcard) and keep 

segmenting and adding with “+” to 1st object. 

B. If already have two separate objects: select 1st object (in “3D objects” toolcard click “Select” next 

to 1st object’s name); then highlight 2nd object’s name (in “3D objects” toolcard) and click “+” – 

this way selected voxels (from 1st object) will become assigned to 2nd object. Now can delete 1st 

object now. 

 

 

How to subtract voxels from existing 3D object 

Highlight object’s name (in “3D objects” toolcard) → select image area and click “-” (or “minus” on 

keyboard) 

Easiest way to select entire separate object (e.g. one of fMRI activation areas that stands alone) – use 

button   

 

 

TUMOR segmentation 

SEGMENTATION tab with anatomic exam loaded (i.e. primary exam is MRI with tumor visible) 

• “3D objects” area (upper right): New → rename by double-click 

• using TOOLS (e.g. “Blow” → “Brush”, Ctrl+) mark tumor on every 2nd slice 

• SELECTION (in toolbar): Interpolate (tumor acquires selection red) 

• SELECTION (area on the right): click “+” (make sure “All slices” is selected) – tumor becomes object 

http://www.neurosurgeryresident.net/
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VIEW tab → “3D object” toolcard tab – select “Surf” at tumor object (tumor must be visible now in 3D; if 

not, go to “Display” toolcard tab and pull histogram right arrow to the right – skull becomes more 

transparent) 

 

Convert fMRI to 3D object 

• make sure primary exam is anatomical exam (and not fMRI) that you will use for intraop navigation 

• SEGMENTATION tab (SEGMENTATION in toolbar → Gray Image → select fMRI) 

• on histogram to move both sliders as far left as possible – makes activation region maximally visible. 

• use “Magic Wand” tool → click on fMRI region → move histogram slider: 

right – as far right as possible 

left – just to the left of data values 

(fMRI region should become selected) 

• [New] → (+) to add to object 

 

 

DTI TENSOR PREPARATION 

IMPORT tab (lower left) → select (using CTRL) MRI, DTI → “Add to view” 

VIEW tab – make sure anatomic exam is primary dataset (but no need to merge any exams) 

TOOLS (in toolbar) → DTI tensor preparation – will open 4-step dialog: 

1. Gradient assignment 

• background masking (eliminates air – represented in blue) – move slider to ≈ 50-300 – 

must remain no blue on brain (blue in ventricles and sinuses is OK) 

− same background mask is applied to all gradients (may check by 

clicking each gradient on the list) 

• check that color boxes on the left of each gradient are green or yellow (if red – means 

patient moved – exclude gradient by unchecking it) 

• optional – check “Smooth Raw Input  Data” – reduces noise 

2. Gradient registration (registers individual gradients to B0) 

• usually gradients are aligned so leave default “Identity” registration type (if misalignment 

was detected, change from “Identity” to “Auto”); if using 2 mm slice thickness, then MRI 

scanning takes longer – may use “Auto” to readjust for patient movements. 

• if all look OK → “Verify All Registrations” 

3. Coregistration (registers gradient dataset to anatomical exam) 

• confirm that reference exam is anatomical exam that you will use in surgery 

N.B. fMRI has only activation regions map (not enough info for coregistration) – 

must be premerged with anatomic exam on another system 

• select B0 and change “Identity” to “Auto” 

• for other exams may leave “Identity” (but check if they merged correctly; if not then 

change “Identity” to “Auto” – system will fuse) 

• “Verify All Registrations” 

4. Tensor computation 

• FA, DEC, ADC must be checked (all other only for research purposes) 

Default values: 

FA 0.20 

• “Compute” 

• DEC (Directionally Encoded Colors) map is automatically shown overlaid on anatomic 

exam 

• DEC is also known as RGB: 

http://www.neurosurgeryresident.net/
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red – fibers left-right (red heart on left) 

green – fibers anterior-posterior (being “green” means moving forward) 

blue – vertical fibers (towards blue sky) 

 

 

 

DTI FIBER TRACKING (TRACTOGRAPHY) 

- use “DTI fiber tracking” toolcard (lower right) 

N.B. check if DTI (DEC, FA, ADC) are fused properly with anatomical exam! 

• drag crosshair to seeding region → “Add” – selection box appears: 

a) choose 3D object (instead of selection box) in drop-down menu 

b) modify selection box: drag or rotate borders (zooming helps), shift box with 

SHIFT+click&drag 

• “Compute” – fibers will appear 

N.B. check “Auto” (next to “Compute”) – draws fibers in real time as you change parameters. 

 

How to filter tract 

- use “Mid Region” and “End Region” – can use another box or segmentation object (e.g. fMRI activation 

region) 

 

At the very end* may “Crop” unnecessary fibers 

*if you change anything afterwards, fibers will be regenerated and will need crop again 

 

TRACTOGRAPHY PARAMETERS 

More Options → Dialog: 

Seed Density (default 1.0) – how many seed points will be generated in each mm3; ↑ (up to 5.0) – 

more fibers. 

Max. directional change (default 45 degrees); ↑ (up to 180 degrees) - more fibers. 

for pyramidal – use 60° (if internal capsule looks too thin, increase to 90°) 

for rubrothalamic – use 45° 

Min. fiber length (default 20.00); ↑ - less fibers (eliminates short spurious fibers). 

3D object distance (default 2.0) – safety margin when generating 3D object from fiber tracts; OK 

to decrease to 0.0 

MPR Line Depth (default 5.0) 

 

FA start value 0.20; ↓ - more fibers (may try 0.0 to start from lateral motor cortex). 

ADC stop value 0.10; does not change number of fibers. 

 

 

CONVERT TRACT INTO 3D OBJECT 

• check “MPR” next to tract name (on “DTI fiber tracking” toolcard) 

• check “Surf” next to tract name (on “3D Object” toolcard) 

N.B. can make object (tract) less puffy by decreasing “3D Object distance” to 0 (“More 

Options” → “Dialog”) 

 

PYRAMIDAL TRACT 

The ability to see the lateral/inferior reaching tracts on CST can be difficult and may be dependent on the 

quality of your DTI scans. 

http://www.neurosurgeryresident.net/
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Put either a start or end region along the motor strip (see the purple bit on the leftmost image). 

It can help to rotate the crosshairs to orient the lines along the motor strip and then turn on the end region 

and stretch the box to cover the motor strip. Alternately, you could use modeling tools in segmentation to 

create a contoured 3D model of the MS and then use that for the start/end region. 

Then you can increase the seed density and max directional change in more options > dialogue box (found 

at bottom right in fiber tracking menu). 

This should show the lat/inf fanning portion of CST along with some crossing fibers so you will likely 

need to crop extraneous areas to achieve a result looking like the picture above. 

 

 

 

RESEARCH TOOLS 

Add-on >> 

 

 

OLD 

The attached file will turn on the Statistics functionality in StealthViz.  Please try the procedure below and let me 
know if you need any help – we could facetime or something similar. 
 
Save attached file to a USB stick. 
Start up StealthViz on the planning station, insert the USB stick, wait about 10 seconds, and then press F9 once to 

mount it. 
Press Alt+F9 to minimize the StealthViz screen. 
Right click and select New Window 
Type  … 
ls  /mnt/USB     and check to see that the xml file is there  
               if the above fails, type        mount /dev/sdb1 /mnt/USB           and repeat above 
 
cd  /opt/Medtronic/StealthViz-1.3/examine_local/hanging-protocols     (note that you can type the first few characters 
of a word and then hit the Tab key to autocomplete the word) 

http://www.neurosurgeryresident.net/
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cp   /mnt/USB/*.xml  system 

press F10 to unmount the USB stick and then you can remove it. 

Double click the StealthViz icon to maximize it. 
Log out and then log back in to StealthViz. 
View a scan (do not load a previous Session – this won’t work for previous Sessions) 
There should now be a tab called “Statistics” beside the fiber tracking tab. 

If not, click on the Protocol menu at the top of the screen, and let me know which one has a checkmark beside it 

 
Go through the normal process to create fiber tracts or 3D models of areas of interest. 
On the View tab, with the Statistics toolcard open, click on Compute 
There will be one row per 3D model, with the stats within that volume from the Primary exam.  You can click/drag 

the divider to widen that panel temporarily. 
 
If you need to calculate the statistics based on different datasets (e.g. if you want average FA within a fiber 
tract): 
One limitation is that every time you change the Primary exam to something different (e.g. to FA or ADC to calculate 
statistics on them), the previously created 3D models disappear (they are associated with whatever was Primary 
when they were created).  If you want to have the same 3D model be used with multiple datasets, you will have to 
do something like: 

create a 3D model (check the MPR box to make a fiber tract be a 3D model) 
use File, Save 3D Objects  to save a Hybrid exam to a directory on disk (should be able to create a new directory in 

/opt/mnav/StealthViz-1.3/examine_local  to put them in) 
use File, Import DICOM and find and load that Hybrid back into StealthViz – it will become a new series under the 

same patient 
Then, for each dataset you want to calculate stats on 

make the dataset you want to create stats on be the Primary, (e.g. FA or ADC) 
and make the Hybrid be the Overlay 
use Tools, Coregistration to make sure they’re merged (will likely be Identity) and checkmark Verified 
in Segmentation tab, use Segmentation menu, Gray Image to switch to the Hybrid, and segment (usually with 

thresholding) the 3D model again (it will now be associated with the new Primary) 
in the View Tab, click Compute on the Statistics toolcard 

 

 
all of this probably gives you an indication of why this functionality isn’t enabled by default …  we have also seen 
issues if you save a Session and then come back in later and try to use the statistics, so try to do all your 
work in one session. 

 

 

NEW 

Logging in as “superuser” to give extra permissions: 
 
Save attached file to a USB stick. 
Start up StealthViz on the planning station, insert the USB stick, wait about 10 seconds, and then press F9 once to 

mount it. 
Press Alt+F9 to minimize the stealthviz screen. 
Right click and select New Window 
Then type the following 
su 

;password;    (password – ask Medtronic team for it / slpt.pdf) 

ls  /mnt/USB     and check to see that the xml file is there  

               if the above fails, type        mount /dev/sdb1  /mnt/USB           and repeat above 

 
cd  /opt/Medtronic/StealthViz-1.3/examine_local/hanging-protocols     (note that you can type 

the first few characters of a word and then hit the Tab key to autocomplete the word) 
cp  /mnt/USB/*.xml  system 

press F10 to unmount the USB stick and then you can remove it. 

Double click the StealthViz icon to maximize it. 

http://www.neurosurgeryresident.net/
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Log out and then log back in to stealthviz. 
View a scan (do not load a previous Session – this won’t work for previous Sessions) 
There should now be a tab called “Statistics” beside the fiber tracking tab. 

If not, click on the Protocol menu at the top of the screen,  and let me know which one has a checkmark beside 
it 

And then follow the remaining steps in the “Old” (above) 
 

 

 

SAVING/EXPORTING 

StealthViz exports/saves 3D objects in Mach rainbow color map – objects can be colored in the Medtronic 

applications. 

 

• make separate sessions and separate hybrid exams for each tract – fibers (tracts) can intersect but one 

voxel can belong only to one 3D object in same session (and, thus, hybrid exam). 

 

There is no straightforward way to export sessions (which contain the fiber tracts as fiber lines) between 

systems with SV on them. 

If you right click on the tract name in the DTI tool card, it does let you save the tract in a format 

(*.am  AmiraMesh) that enables you to transfer it to Amira.  But, there’s no way to import that into 

another copy of StealthViz. 

 

 

 

FILE → SAVE 3D OBJECT 

– save to CD/USB 

USB – mount with F9 → create new folder on USB → save. 

CD – first need to save exam locally (Look in: opt/Medtronic/StealthViz-

1.3/examine_local/saved_results – create new folder here [e.g. “Patient DTI”] and go into it 

→ OK → Save – exam will be saved to this folder) → then burn CD (click F11 – opens CD 

burning window → select patient, etc.) 

 

 

FILE → EXPORT 3D OBJECT 

– send to Stealth Station directly (over network) or save on local hard drive; click OK/accept – will save 

to the directory where FrameLink / Cranial MACH can find it. 

N.B. select “Burn Hybrid” (will save 3D objects fused with anatomical exam) 

 

 

EXPORT tab 

Only exports snapshots! 

• select needed snapshot → Save 

• may choose USB: insert USB → press <F9> to mount → Save → press <F10> to unmount 
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